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Migration Tutorial

Tutorial for migration of Delphi/C++Builder localization projects to Multilizer 6.0.

Background
This document is intended for Multilizer users that have been localizing software using component localization.

Because Multilizer components have been removed, Multilizer 6 users have to migrate to binary localization
technology that was introduced in Multilizer 5.0.

Following table summarizes the differences between component and binary localization.

Feature Component localization Multilizer 6
Binary localization

Basic features (also as end-users will experience it)

Language change on the fly Yes Yes

Translation of UI Yes; requires Translator Yes; no components/code needed.
component on every form.

Translation of hard-coded strings Yes; requires Multilizer’s Yes; requires use of resourcestring
Translate() function. clause (Delphi) or resource strings

(C++Builder).

Different UI layouts for each target | No. Yes. Wysiwyg allows localization of

language. form layouts.

Performance

Storage for translations MLD (binary file), text file, or Resource DLL's or resources in the
database. EXE.

Impact on localized EXE Moderate; strings are translated No impact when running software;

performance on run-time each time a form is works just as any software
shown. compiled with Delphi/C++Builder.

Impact on localized EXE’s code A few hundred Kilobytes. 0 Kilobytes (without language

size. change on the fly).

EXE startup performance. Moderate impact, if there are lots No impact.

of translations.

Localization engineering specifics

Required localization source. Requires Delphi/C++Builder Requires compiled binary (e.g.,
project, and executable. EXE).
Required software re-engineering. Drop Multilizer Translator

component on every form in the
application, and Dictionary
component on the mainform.

Support for visual form No. Yes.
inheritance.

Table 1: Comparison of Multilizer 6 localization and Component Localization
1. Open project
Before opening existing Multilizer 5.x project, take a backup of it.

When opening an old Multilizer project, Multilizer will popup the following informative dialog.

Upgrade Information

[This project was created with Mulilizer 5.1.81.
It will be uparaded to Multiizer E.0 project format.
Press Continue to proceed. Press Help to get more information.

[ Cottinue ][ Cancel ” Help l

Figure 1: Opening an old Multilizer project will make Multilizer 6 upgrade it,

If you want to cancel the upgrade press Cancel. If you want to start the upgrade process press Continue.
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Opening Multilizer 5.x component localization project

If Multilizer 5.x localization project was based on using Multilizer components, Multilizer 6 will show following
kind of dialog; as Multilizer 6 doesn't include components the Delphi/C++Builder project must be modified.

Upgrade Information &l
Fallawing changes were made during project upgrade process:

- Converted a component localization target, "E:stest\Component_L10NAD 7 _framessFroject].dpr”,

to a binary localization target, "E:Mtest\Component_L10MAD7_frames'Project] . exe”

- Hint: Form TForm1 contains an old Multiizer TlvBinaryDictionary component "l+BinanyDictionary1"™. You can remove it.

- Hint: Form TFarm1 contains an old Multiizer TlvTranzslator component 1T ranslator! . You can remove it.

You need to modify the form and zource code files,

Presz Help to read the Migration Tutonal, Press QK to complete the upgrade and review the log,

| ok || Hew |

Figure 2: Multilizer 6 opening a component localization project.
When converting a component localization project to Multilizer 6 project, following conditions must be met:

e The executable (referred in Delphi/C++Builder project file) must be found.
e If dictionary (MLD-file) is found, Multilizer will import translations.

If executable is not found (or Multilizer 5.x project wasn’t based on Delphi/C++Builder project file but on
forms), you have to create a new Multilizer 6 project and then import translations from the dictionary (MLD-
file).

Multilizer 6 user interface

After this, Multilizer opens the project and displays the translation grid as usually. Before going further, save
the project (Don't choose Save As...).
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Figure 3: Multilizer 6 UI with an old (ML 5.x) project opened.

When opening a Multilizer 5.x project, Multilizer 6 will import all languages with accompanying translations.
These strings are shown in ‘Forms’ and ‘Strings’ nodes in Project Tree.

If there were hard-coded strings in ML 5 project (in ‘source’ node in project), they were not imported yet. If
there were project strings in ML 5 project, there weren’t imported either. See chapter 5 to import these.

As shown in picture above, there is a lot of non-string data in project. In order to hide them, select appropriate
filter (View->Filter...).
Grid Filter X]

Friorities Others Text Custam
Data Types | Translation Statuses Fiow Statuses

Binary value

Boolean value

Calar

Floating point number
Fant

IME mode

Integer number

Fieading order
v Short cut
| String
Paint
Size
Currency
Enumeration

[ ok || cencel ][ Defaur |[ Hep |

Figure 4: Defining a filter to show strings only.
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2. Define type of localized files

Before going further, the type of localized files needs to be specified; right-click target-node in project tree
(Currently selected in previous image) and choose properties.

Delphi Target E|
Eile
% delphiS turkishProject].exe E]
Options
Project | Encodings | Outpwt | Fonts || IME Resources
Output filez Rezource file options
[ Localized files Copy all resources
Resource files Wite to root directory
[ Multilingual file ] Embedded rezource fil
Output directory:
E:Mestudelphi®_turkish B
[ K ] [ Cancel ] [ Diefault ] ’ Help ]

Figure 5: Output settings for binary-localized files.
Binary localization supports three kinds of localization output file types:

¢ Localized file produces one exe for each language.
e Resource files produces files with compiled resources, one for each target language. This is the format
that Borland® promotes. Using this format enables run-time language switch; implementation is

described in chapter 4.
o Multilingual file includes all translated resources in one executable. It starts in the language matching

Windows default locale.

3. Configurations that affect localization work

Configurations that affect the work with Multilizer project are found on project tab. Read this chapter to know,
the reason for specifying Delphi project (and source) location, and Delphi DRC-file location.
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Delphi Target gl

[

Options

Project |Encodings Output | Fonts || IME Resounces

DRC file name:

Options

Scan images from the form data
Set BiDiMode property

[ Mirrar farms

Form scaling
(%) Dizable scaling
() 5Scale forms

 lgnore

[ Ok H Cancel ” Drefault H Help

Figure 6: Delphi target, project options.
Enable display of visual inheritance

Multilizer 6 is capable of showing visual inheritance of forms. This reduces time spent on translation;
translations populate inherited forms just as the same code is propagated to inherited classes.

Inherited items (e.g. dialogs) are marked with a small arrow on the icon in project tree. Inherited items on the
form are also marked with the same kind of arrow.
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Figure 7: Visual Inheritance: TCheckFrame is an inherited from. Only one string requires
translation as other translations are inherited.

Enable full context for resource strings

Delphi compiler generates numeric id’s for all strings declared with resourcestring clause in Delphi source code.
These numeric id’s may change when recompiling the software, which changes the context of the string in
Multilizer. In order to keep the context the same, Multilizer needs to have access to the DRC file generated by
Delphi compiler. Using this Multilizer is able to use a context that is the same as resourcestring constant name.

Turn on this setting by specifying DRC file name.

=E @ Froject] axe Context I Mative 4
" (3 Bitmaps || 408465340 - Dock zone has no cantral
& 0 Cursors +| 4054 85333 - Dock zone nat found
B ? ”“:Basehame < 4093 B5472 %s (%, line %)

P -
"B TCheckFrame ,| 4040 65432 n;:;els not & valid component

& TForm1 z 4095 55520 %5 is not a valid integer value
LB TIvselectResourcel | + 4089 F2416 %s not in a class registration
-- 3 Icons = group
| +| 408965414 %5 Seek not implemented

3% 4080 +| 408665373 2Abort

355 4081 | +| 4085 55344 B4

- 3bE 4082 | +| 4087 B5390 SA

- 3B 4083 | +| 4057 B53B6 &Close

- 2he 4084 +| 4087 55385 2Help

Figure 8: Strings with resource id’s as context; Delphi compiler creates the id’s, and on each
compilation resourcestrings may get different id’s.
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Figure 9: Strings with full context; context is formed out of unit name and resourcestring

constant name.

4. Changes in code

While Multilizer 6 takes care of upgrading the project to the new format, Developers have to take care of the
changes in Delphi/C++Builder project.

Generally there are two things to do:

1. Remove Multilizer components
2. Stop using Multilizer’s Translate() function. These strings were placed in “source” node in ML 5.x
projects, after doing the change below the strings will be placed in “strings” node in ML6 project.

Delphi example: if you earlier had Delphi code like this:

var
s: String;
begin
s := IvDictionaryl.Translate(‘Hello world!’);
end;
change it to
resourcestring
SHello = ‘Hello world!’;
var
s: String;
begin
s := SHello;
end;

C++Builder example: if you earlier had C++ code like this:

AnsiString s

change it to

IvDictionaryl->Translate ("Hello world!") ;

#include "resources.h"

s = LoadStr (SHello) ;

and create a string resource ud file (resources.h)

#define SHello

1

and add a string resource file (resources.rc) to the project
#include "resources.h"

STRINGTABLE

BEGIN

SHello "Hello world!";

END



Multilizer® technology article #602
2004-10-25

Dynamic language change can be added if output files are “Resource files”. Use SelectResourcelLocale
function (located in IvResLangD unit) to show a language selection dialog. Add IvResDLL in mainform’s uses
clause to enable runtime language switch.

Single EXE application can be created if output files are “"Resource files” and "Embedded resource file" is
checked. Call ExtractResourceDlls function (located in IvResDIl unit) in the initialization block of the main form
to extract the embedded resource DLLs on runtime to the application directory (or to the personal directory if
the user has no write access to the application directory).

Translation of Common Dialogs is enabled, if you add IvDialogs.pas to the Project Manager, or add
IvDialogs unit to the uses clause anywhere in the application.

5. Finalize migration

After changes in code, build the new executable(s). Once the native executable(s) are working properly, rescan
them in Multilizer project.

Now Multilizer will find new strings, if you used resourcestring clause as described in previous chapter.
Translations for these can be imported from Multilizer 5 project; choose File=>Import... and specify location of
the Multilizer 5 project.

Finally build localized items in Multilizer and test them.
Other migration paths

Migrate from Multilizer 5 binary localization projects

It's easy to migrate to Multilizer 6; simply open ML 5 project in Multilizer 6. No changes in Delphi/C++Builder
source code are required.

Migrate from Multilizer 5 projects based on Delphi/C++Builder forms

Multilizer 5 projects that were migrated from Multilizer 4 are based on forms. This means that the targets in
Multilizer 5 projects were separate forms files instead of Delphi/C++Builder projects. If you attempt to open
this kind of Multilizer 5 project, you will get the following message:

Error

Could not upgrade Multilizer 5.x project:
Form with components, Form with components, Form with components, Source code with components, Form with components
localization is not supparted any mare.

Keep using Multilizer 5. 1.

Figure 10: Attempt of upgrading ML 5.x project based on separate Delphi/C++Builder form
files.

In order to migrate to Multilizer 6 you have to:

1. First create a Multilizer 6 project
2. Then import translations from the Dictionary (MLD-file).

Migrate from Multilizer 4 or older projects

Best results in this migration path are achieved by first creating a new Multilizer 6 project, and then importing
(File=>Import...) translations to it.

In addition the same code changes as in migration from Multilizer 5 component localization project needs to be
done.
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Conclusions

Even if Multilizer 6 contains upgrade possibility, it can be faster to upgrade by creating a new project and then
importing existing translations. This is true especially if migrating from older projects or from component
localization projects.

Creating a new Multilizer 6 project is many times even better than upgrading; creating a new Multilizer 6
project allows users to start working systematically. For example before translating (or importing translations
from old project) users can specify which components/properties are exlucded/included. In addition user can
choose which resources are handled, and whether bitmaps for example should be localized. With a few settings
in @ new project user can reduce the work involved in localization considerably.
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